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Eclipse IDE

* Eclipse is an open source community whose projects
are focused on building an extensible development
platform, runtimes and application frameworks for
building, deploying and managing software across
the entire software lifecycle. Many people know us,
and hopefully love us, as a Java IDE but Eclipse is
much more than a Java IDE.

* http://www.eclipse.org
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Eclipse IDE

* The Eclipse open source community has over 200
open source projects. These projects can be concep-

tually organized into seven different "pillars" or cat-
egories:

* Enterprise Development

- Embedded and Device Development

* Rich Client Platform

* Rich Internet Applications

* Application Frameworks

- Application Lifecycle Management (ALM)

* Service Oriented Architecture (SOA)
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Eclipse IDE

* The Eclipse community is also supported by a large
and vibrant ecosystem of major IT solution pro-
viders, innovative start-ups, universities and re-
search institutions and individuals that extend, sup-
port and complement the Eclipse Platform.

* We are interested in the Eclipse Integrated Devel-
opment Environment (IDE)
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Eclipse IDE
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Eclipse IDE

* Eclipse IDE is open source, it has the Eclipse Public
License (similar to Mozilla Public License)

* Is built in Java, and thus is multiplatform

* The user interface is implemented with Standard
Widget Tool (SWT), a library that wraps native plat-
form controls (responsive and integrated Ul)

* Works very well in the main platforms: Win, Linux

and Mac
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Eclipse IDE

* In this context we are insterested in the Eclipse de-
velopment tools
* Programming Languages:

* Java, C/C++, Pascal, Haskell, PHP, PascalFC, ActionScript
(Flash), Ada, Groovy, Python, JavaScript, Scala, Linux
scripts...

* Control version systems:

- CVS, SVN, Git...
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Eclipse IDE

* Issue tracker systems:
* Bugzilla, Trac, GoogleCode, Redmine...

* Other development tools
* Tests (JUnit), Continous integration (Hudson, Jenkins),
Documentation...
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) ’ 43 * Uses the Eundle.properties to test MbBundle's behawviar,
B[] MbBundle java an #
b [1] Openviewaction java 41 @Test
b [J] Perspective java 42 publi¢ void testExistingResource() {
: ; 43 String 51 = MbBundle.gethiessage(ProjectView.class, "add_new_pwt_sat"y;
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initializelpplication3etup(fzetupFilePath)

g% ClearQuestAPls v
[= config n < | >

[== Configuration =
(= CPErrorlssues AccuRey Console | AccuRey Search)status mmtuw Console g
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File Edit Mavigate Search Project

BH-EHE S| - K-

Source  Refactor

Fun  ‘Window  Help

SRS ® Y eE

B ¥ Rw e |ileg-

ﬁ |ZE Package Explorer v X X [ Properties = }:b @ b4
I% o o F | E .=§=' |} Selection Properky | Yalue | |
w - 1o Test i_1 Marquee actionCom...  Click me
--F# (defaul: package) 3% Choose Bean background 238,238,238
+-[J] Testwindow.java f ; i EOMPAONEN. .. LIMKHOWN
; . {=F Swing Components disabledlcon
+ [h JRE Syskem Library [j2rel.5.0]
=3 JEutton enabled true
font Dialog, bold, 12
] ICheckBiox foreground  51,51,51
@ JRadioButtan horizonkal,..  CENTER
I IToggleButtan harizontal,..  TRAILING
JLabel icon
G NEenonic
0 ITextField name
ﬁ?JPasswnrdField preferreds... 83,26
ITextArea pressedlcon
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Eclipse IDE

* Other side tools
* Latex
XWiki
UML diagrams
Database access
Web server integration
Monitoring, profiling, logging management...
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Eclipse IDE »

* Eclipse IDE is a modular system

* All tools are available by means of plugins

* A plugin is like a addon or complement that can be in-
stalled in the Eclipse IDE

* There are commercial and open source plugins

* There are official Eclipse plugins and other ones de-
veloped by third parties (organizations, companies, indi-
viduals...)

* Of course, Eclipse has their own “"AppStore”

eclipse : '
maﬂ rketplace http://marketplace.eclipse.org
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Eclipse IDE

* Eclipse Distributions

* Eclipse can be downloaded in preconfigured “distribu-
tions”

* They are called Eclipse Distros or Eclipse packages

* Each distro has a set of related plugins to accomplish a
task (Java development, C/C++ development, web devel-
opment...)

* There are fully open source free distros and commercial
ones (with commercial plugins)

* Eclipse has native code (for Ul). For this, you have to
download the Eclipse distro for your platform
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Eclipse IDE

* How to download Eclipse
* Official Eclipse packages

* Preferred way to obtain Eclipse
* http://eclipse.org/downloads/

* MyEclipse (Commercial)

* Advanced commercial plugins
* http://www.myeclipseide.com/
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Eclipse IDE

* How to download Eclipse
* EasyEclipse

* Discontinued

* http://www.easyeclipse.org/
* EclipseGavab

* Developed in the URJC to first courses students

* http://www.sidelab.es/projects/eclipsegavab/
* Aptana

* Eclipse distro oriented to Web development

* http://aptana.com/
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Eclipse Downloads - Chremium

E Eclipse Downloads

K lj;_-” @ () eclipse.org/download

Home

Downloads  Users  Members  Committers  Resources  Projects

About Us

isit other Eclipse Sites

~ @

Packages

Compare Packages

Developer Builds Projects Indigo Torrents

Older Versions

= Eclipse IDE for.Java EE Developers, 210 mB

Downloaded 1,901,787 Times Details

Eclipse Classic 3.7 173 mB

Downloaded 1,631,111 Times Details Other Downloads

Eclipse IDE for Java Developers, 121 B
Downloaded 575,855 Times Details

Promoted Download

CloudBees Toolkit for Eclipse

Making it easy to create and menitor Jenkins builds frem Eclipse.

Eclipse IDE for C/C++ Developers (includes Incubating components),
107 MB

Downloaded 306,206 Times Details

Eclipse IDE for JavaScript Web Developers, 10s B
Downloaded 109,643 Times Details

Eclipse IDE for Java and Report Developers, zsome
Diownloaded 69,173 Times Details

Eclipse Indigo (3.7) Packages for RIS

i Linux 32 Bit
Linux &4 Bit
i Linux 32 Bit
Linux &4 Bit
i Linux 32 Bit
Linux &4 Bit
i Download
i Linux 32 Bit
Linux 64 Bit
i Linux 32 Bit
Linux 64 Bit

i Linux 32 Bit
Linux &4 Bit

El Me qusta

Hint:

You will need a Java runtime
environment [(JRE) to use Eclipse (Java
SE 5 or greater is recommended). All
downloads are provided under the terms
and conditions of the Eclipse Foundation
Software User Agreement unless
otherwise specified.

Save time

Get RCP Training

LR

Installing Eclipse ]

m Install Guide -
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== &' Ruby
()= Yariables | ®a Breakpoin @Pascal Yar i 3181 Registers | 2 Modules = O
Mame Yalue
result : longink 1z
getvalue : longink 1z
L >
[£] €.c [F] prog.pas [F] main.pas [¥] uridad.pas &2 Ui Main.rb 74 = O 5= cutline 52 & ~ O
function getValue : longint: A &n outling is nok available,
bhegin
getWValue := 1Z;
> end;
end .
W
El console 52 2 Tasks | [20 Problems | €2 Executables | [ Memory = UH'EII‘E” = E-r5-"0
TurboPascal.exe [Pascal Local Application] C:iDocuments and SektingsiPatxiworkspace) TurboPascaliDebug TurboPascal exe (24)02/09 17:42)
= .
Writable Insert 11:1
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Eclipse IDE

* The official Eclipse Distros are installed following

the steps:

* Download and install Java SE Runtime Environment (JRE)
* Windows: Oracle JRE from http://oracle.com/technetwork/java
* Linux:
* Oracle JRE from web page or from repositories
* OpenlJDK from repositories

* Mac: Available from Apple
* Download Eclipse in .zip or .tar.gz
- Decompress Eclipse file

* Eclipse is launched executing “eclipse” native ex-
ecutable in eclipse folder
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Eclipse IDE

Eclipse needs a folder to store configuration data
This folder is called workspace
The workspace path is asked to user every time he launch Eclipse
Is recommended to use one different workspace for each different
task/context

* One ws per subject

* One ws to final master project
* One ws to experiment with some new language/technology

M Workspace Launcher

Select a workspace

Eclipse stares your projects ina folder called a warkspace.
Choose a workspace folder bo use For Ehis session.

Warkspace: [ v | | Browse.. |

Lse this as the default and do not ask again

|  Cancel |l oK J
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Eclipse IDE

* When you start Eclipse from a brand new work-
space, a "Welcome” page is shown

* Is a web page with information about Eclipse and
the currently installed plugins
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Java EE - Eclipse

File Edit Mawigate Search Project Run  Window Help

@ Welcome &3

Eclipse Java EE IDE for Web Developers

'r’-_j) Overview Tutorials

}5_ Get an overview of the features - Go through tutorials

@ . Samples (./‘x.} What's New
Try out the samples ™/ Find out what is new
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Eclipse IDE

-

Java EE - Eclipse

File Edit Mavigate Search Project Run Window
Fe fvOvQr |G 6 @ o0 |2 2 [(Soma
[ Project Explorer 23 =0 = O || g% outline 22 [E] Task Lis =0
& -
An outline is not available.
« " : You can
The “parts” in which
. : . rearrange, move,
the window is divided L
e maximize and
are called “views .
close views to
configure Eclipse
to fit your needs
[3_‘ Markers £3 E] Properties | ik Servers &Data Source Explorer| [B5 Snippets = =08
Description Resource Fath Location Type
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Eclipse IDE

* If you close a view it can be shown again

-

Java EE - Eclipse

File Edit Mavigate ch Project Run Window Help

Show View

MNew Window
ew Windao Ej’!nf_‘?Ja\raE

[ Project Explorer 52 =lm = O || g= outline 52 [E] Task Lig [l e

&
4

=
B = General

B = ARt

B = AFI Tools

B = OVS

P = Data Management
B = Debug

B = Help

B = Java

B (= Java Browsing

B = JavaScripk

B (= JavaServer Faces
bR JAX-WS

B = P8

B (T Bdseluers

An outline is not available.

Mavigation

Web B

[;_\ Markers 53 E Properties | &7 Servers ﬁ Data Source Explorer| [B5 Snippets

0 items
Description Resource Fath Locakion Type

Cancel

n* 0 items selected
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Eclipse IDE

I\\

* Eclipse has severa

task at hand

* Programming perspectives
* Java, Java EE, C/C++

* Debug perspective

* Control Version systems perspectives
* SVN repostory exploring, Git, CVS
* Team synchronizing

* Other perspectives
* XML, JPA, Database debugs...

* The available perspectives depend on your eclipse
distro and the installed plugins

perspectives” depending on the
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o

Java EE - Eclipse

Search  Project  Run  Window Help
ﬁ' Iﬁ_lava EE!

= G e EE et e Dcbug = O|| 5= outline 8 . [ TaskLlis| = O

Show View

e

Cusktamize Perspective... i g Open Per;pectiue
Save Perspecti il
ki ERINEEELIE .. E 5 WS Repositary Exploring

Ferspective =
Database Debu
Close All Perspectives Li:; ’

B f@ Catabase Development
Havigacion

Web Browser j; _[.l:::aug

Freferences E‘J Java Browsing

lr_?' Java EE (default)

'EgJ Java Type Hierarchy

33" Javascripk

H JPA

(1) Planning

1= Plug-in Development
E Remote System Explorer

({5 Resource

Eﬁl SWM Repository Exploring
[Bll markers 32 B Properties | 4 Servers | 8 Data Source Exq ED Team Synchronizing i
0items
Description Resource Path

|  Cancel ,[ oK

_

ik 0 items selected
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CVS Repository Exploring - Eclipse

File Edit Mavigate Search Froject CWS Run  ‘window Help

I} CVS Repositaries 5% g B B Y TO0

Each perspective has the
most suited “views” oriented
to solve a specific task

[E'ﬂTasl» Repositories &3 ﬁ = =08 |'§_|l History 232
¥ = Tasks

ﬂg Local
¥ (= Bugs

ﬂ__ Eclipse.org

B

ﬁ |%|OJS Repositnr...| ﬁ?Java EE

= 8

You can change the current
perspective using the toolbar
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appcelerator ‘Pmmu,,@
— S5
PyDeV%

Technology
Winner

PyDev is the Eclipse plugin to develop with Python

* Is being developed by appcelerator, the Aptana company

* Itis not an official Eclipse plugin (but this is not important)
* Can be used to do Python, Jython and IronPython devel-
opment

* Itisincluded in Aptana (Eclipse Distro)

* It is open source (Eclipse Public License)

http://pydev.org/
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* It comes with many goodies such as:

* Django integration * Mark occurrences
* Code completion * Debugger
* Auto import * Remote debugger

Syntax highlighting
Code analysis

Go to definition
Refactoring

Tokens browser
Interactive console
Unittest integration
Code coverage

MSWL: Official Master's Program on Libre Software - Development Tools



& PyDey - Robots/src/robots/tests/test_robot.py - Eclipse SDK - II:I|5|
File Edit Source FRefacktoring Mavigate Search  Projeck Pydey  Run Commands  Window  Help

| 5 - O ®|BF-0-Q- |52 GO D [ %5 Debug | pyDev >

r R - "y
% pyDev Package Explarer 53 = B [F] core (EI test_robob &3 = B
= <}~==E> | :{—_:p = import unittest AI.
B = Robots
Iél---é%src ~zlass TestCase (unittest.TestCase) :
Elﬁ roboks

- def testRobhots(sel1f):
from rohots.core import Robhot
robot = Rokhot()
rohot . Walk()
rohot.3ayHello()

o B my.py
=
..... !“I .project G @
E ShG r

----- |=| . pydevproject .
- e python {D:bintpython265)python, exe) 1t _nﬁ:me_ S-:.astemEerr
unittes (& systemesit

€L svs execubable - setuptools. command 2asy_install
€L syvs_ maxsize - wind2oom, kest, beskshel

€L svs version - diango, core, servers, basehttp
X sys_wersion - platform

B i tests

----- @'_init_.py
@ kest_robok,py
_init__.py

”EE ogtline 52 laz :E,: :n: = |j\ o sys_ver.sicun - wsgiref..simpl.e_server _
. @SyscunﬁgTestCase - diskutils, kests, test_sy=config
I':”"I:'E Filter besdt [ sysdate - sqlalcherny. sql. Functions
s A nittest €L svsfile - numpy  distutils, systern_info
B k| TestCase L2 svsid - xml,sax.saxutils ;I
: Press CtH+Space For ternplates,

El @ kestRobots
“e d_ mobat (robots.core)

4 o

J [ | Writable

Insert | 11:12 J
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* Installation
* Be sure that python is installed in your system

mica@mica-laptop: ~

gmica-laptop:~% python
JF01+ (r271:86832, Apr 11 2011, 18:13:53)
5, 2] on linux2
lp", "copyright", "credits" or "license" for more information.

* If not, install it :)
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* Installation (2)

* Be sure you have an Eclipse distro somewhere in your
disk and execute it

* Try to use a modern version (last one is 3.7 aka Indigo)
* Launch Eclipse with an user with write permissions in the
eclipse folder itself (needed to install the plugin)
* In Eclipse
* Menu Help > Eclipse Marketplace
* Type "PyDev"” in Find box and clic on "Go” button
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Eclipse Marketplace

Eclipse Marketplace

Select solutions to install. Press Finish to proceed with installation.
Press the infarmation button to see a detailed overview and & link to more infarmation.

Search | Recent | Popular | Installed

Find: [0\ pydev & | | All Markets + | | All Categories = B

PyDe¢% PyDev- Python IDE for Eclipse share (i)

| |
® I n St a I | a t I O n Pydev is a plugin that enables Eclipse to be used as a Python IDE (supporting also
Jythen and IranPythan). It uses advanced bype inference techniques to provide .
by Appeelerataor, EPL | Install |
. 1\ I 17 - T
[ J D | t tt IDE Pythan Aptana Pydev Django
O ClIC ONn 'INSta ution
Pyde¢% PydevExtensions share (i)

I n W Py D eV — Pyt h O n I D E fo r Pydew Extensions is now merged with Pydev, and its once closed source code has

become open source. Thus, there is no more Pydev Extensions, only the open source...

. by Aptana, EPL Learn mare
Eclipse” y
o Eclipse Color Theme share (D)
" " L
® G O t h ro U ht d I a | O S W I t h Eclipse Color Theme makes it possible to switch color themes conveniently and
without side effects. After the installation, go to .

by Felix H. Dahlke and Roger Dudler, EFL | Install |

"Yes” "Next” "Accept” e e o tenes
“Install” “"Restart” or similar
options...

* Be patient... if download B
fails, restart.

@ < Bal MNext = |  Caneel | Finish
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* Installation
* After Eclipse restart, you can open the new "PyDev” per-
spective
* Menu "Window > Open Perspective > Other...”
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r
-

PyDev - Eclipse

File Edit Mavigate Search Project Pydev Run  Window Help

| @ PyDev| B3Cv5 Repositor.. 3% Java EE

2 PyDev Package Explarer 53 = 8 =8 EE Qutline &3 =8
E <}1=={-:> ﬂ :"‘l__:=> o e
Source flle edltor area An oukline is nok available.
Project and File Source file
explorer members
(classes,
Folders are methods,
shown like functions...)

“packages” in
the python sense

[ Problems &2 ¥ =0

0items
Description Resource Path Location Type

Source code errors
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» Configure Python Interpreter in Eclipse
* After installing it, the first thing you must do is config-

ure the Python interpreter.
* Menu “window > preferences > PyDev > Interpreter —

Python
* Try with “"Auto Config” button, that will try to find it in

your PATH

MSWL: Official Master's Program on Libre Software - Development Tools




Preferences

(EI] Python Interpreters

= General .
Python interpreters (e.q.: pybhon. exe)
B Ant
Mame Location
B Data Management |t |
= python JusrfbinfpythanZ. 7 -
b Help | Aute Config |
B Install/Update -
B Java | Remowe |
B Java EE Up
B Java Persistence [
awn
b JavaScript
> Mylyn i Libraries || Forced Builtins | Predefined EEm-‘irunment & String Substitution Variables
B Plug-in Development
System PYTHOMPATH
¥ PyDev _ _
Builders T!-LS'_-.rstem libs | Mew Folder |
libfpythonz.7 I
b Debug ",;' Jusrflibfpythaon —
> Editar = fusrflibfpythonz. 7/plat-linuxz | gg/<ipls) |
= . .
libfpythonz. 7/lib-tk
Interactive Cansole ﬁ' fusrflib/pythonZ 7/l |  Remove |
libfpythonz.7/lib-old
Inkerpreter - lran Pythan &' [usrflib/pythonz.7/lib-o
libfpythonz.7/lib-dynload
Interpreter - Jythan ﬁ' Jusr/lib/pythonZ 7/lib-dynloa
l lib/pythonz. 7 dist-pack
Interpreter - Python &u fusrflocal/lib/python2. 7/dist-packages
Logging = fusrflibfpythonZ2 7/dist-packages
PyLint Eu fusrflibfpython2.7/dist-packages/PIL
PyUnit Eu Jusrflibfpymodules/pythonZ 7/gtk-2.0
Scripting PyDev ‘:u fusrflibfpythonz.7/dist-packages/gst-0.10
Task Tags ﬁl Iusr,flfI:u,fp:-.rthunz.?fdist-packagesfgtk-2.IZI
b Remoke Systems gu Jusrflibfpymodules/pythonz. 7
b Run/Debug s fusrflibfpymedules/python2. 7fubuntuone-contral-panel
T fueeflibdosmmadulae fnkhan® Tloboankuana cliank
B Server
B Team | Restore Defaulks | | Apply |
@ [  Caneel | l oK J
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* A Python Program is
developed in a Eclipse
PyDev Project

* Menu "“File > New >
PyDev project”

* Select a name forit

* Clic “Finish”

PyDev Project

Projeck name is empky

Project name: [

Project conkents:
[ Use default

Froject type
Chonse Ehe praject type

@ Python Jython Iron Python

Grammar Version

[2.7

Interpreter

| Default

Click here ko configure an inkerpreter nak lisked.

@ Create 'src’ folder and add it to the PYTHOMPATH?
Add project directory to the PYTHOMPATH?

Don't configure PYTHOMPATH (to be done manually later on)

@

| Caneel |

MSWL: Official Master's Program on Libre Software - Development Tools




You are ready to create py-
thon modules (source files)

and python packages
(folders)

Menu “File > New > PyDev

Module”

Write Name “test_app”
Clic in “Finish” button

Write the module:

print "Hello World!"

Create a new Python module

Source Folder | /PythonTestfsrc

Package
Mame t:lt_ﬂpp
<Emply=
Module: Class
Module: Mai
Template auie: Ham
Module: Unittest
Madule: Unittest with setUp and tearDown
® [ Cameel | l
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* Execute a module

* Launch the program
* The first time: Menu “"Run > Run As > Python Run”
* The following times: Clic Green Play toolbar button

* Program Input/output
* The Console view appears with the program output
* Is like a shell

* Finishing the program
* The program can be stopped any time with the stop button in the
Console view
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PyDev - PythonTest/src/test_app.py - Eclipse

File Edit Source Refactoring Mavigate Search Project Pydew Run  Window Help

v &y ¥ v Ef | @@ PyDev| EgCvs Repositor.. 7@ Java EE

F PyDev Package Explorer £3 =B E] test_app o3 = O EE Outline 3 =B
i noA
B & E . 1% = Lo
! Created on 22/09/2011 il
¥ [~ PythonTest I
¥ [Hsrc @author: mica
" @ [ |

2 python (fusr/bin/pyfhonz.7) ] .
print "Hello World!"

Launch Module

Stop the program

&Prnhlems El console &3 4 % % 5™ Eﬁ'é”@' = (= B f{j' = O

zterminated= fhome/micafws/PythonTestfsreftest_app.py
Hello World!

Console — 1~

w4 Writable Insert 721
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